
 
 
 
 
 

iRise Learning Roadmap 
 
 
 

 
 
 
 
 
 

Updated for iRise Studio 
Version 8.7 

April 13, 2011 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Prepared by 
Bill Smith, iRise Inside Sales 

©2011 iRise, Inc. 
 
 

Please send corrections and suggestions to bsmith@iRise.com   



iRise Learning Roadmap 8.7 Page 2 Printed 4/13/2011 9:41 AM 

 
1.  Introduction............................................................................................................................................ 3 

1.1.  Intended Audience ........................................................................................................................ 3 
1.2.  Learning Approach ........................................................................................................................ 3 
1.3.  A Word to the Wise ....................................................................................................................... 3 

2.  Get the Big Picture First ........................................................................................................................ 3 
2.1.  iRise Website ................................................................................................................................ 3 
2.2.  Webinars and User Group Presentations ..................................................................................... 3 
2.3.  Demonstrations ............................................................................................................................. 3 
2.4.  Product Videos .............................................................................................................................. 4 

3.  Training and Mentoring Options ............................................................................................................ 4 
3.1.  iRise Educational Services ............................................................................................................ 4 
3.2.  Mentoring ...................................................................................................................................... 4 

4.  On Your Own with iRise Studio ............................................................................................................. 5 
4.1.  Quick Reference Card (10 minutes) ............................................................................................. 5 
4.2.  Getting Started Guide (1 to 2 hours) ............................................................................................. 5 
4.3.  Explore the Menus (10 minutes) ................................................................................................... 5 
4.4.  Learn about Widgets (1 hour) ....................................................................................................... 6 
4.5.  Study Sample Simulations ............................................................................................................ 6 
4.6.  iRise Help System ......................................................................................................................... 7 
4.7.  iRise Support ................................................................................................................................. 7 

5.  Simulating with iRise Studio .................................................................................................................. 7 
5.1.  Visualize with Screen Shots and Low Fidelity ............................................................................... 7 
5.2.  Simulate New Functionality from Scratch ..................................................................................... 7 
5.3.  Simulate in High-Fidelity When Appropriate ................................................................................. 7 
5.4.  Optimize with an Asset Library & Collaboration ............................................................................ 7 

 



iRise Learning Roadmap 8.7 Page 3 Printed 4/13/2011 9:41 AM 

 

1. Introduction 

1.1. Intended Audience 

This iRise Learning Roadmap is for new iRise users and individuals who have been 
asked to evaluate iRise for possible adoption into their organization.  It is a guide to 
available resources and a road map for efficient learning.  It is not a user manual or 
tutorial and does not provide detailed instruction on how to use iRise. 

1.2. Learning Approach 

While there is no substitute for hands on experience, getting the big picture before you 
start modeling with iRise Studio will make you more productive in the long run. 

Therefore, we suggest you begin learning iRise with a review of some of the written 
information, presentations and product demonstrations at www.irise.com.  Next, orient 
yourself to iRise Studio by working through online tutorials, and if you have time, go 
through one or more of the eLearning courses and the Visualization Workbook (aka 
Mentoring Workbook). 

1.3. A Word to the Wise 

iRise is a powerful tool that empowers skilled and motivated users to have an enormous 
impact on the success of their project and organization.  It is also a lot of fun, so by all 
means take it as far as your creativity, skill, and time allow. 

However, always keep the fundamental principle of iRise modeling in mind:  only simulate 
as much as you need to, to answer a question or achieve the objective before you.  In 
short, avoid the common mistake of trying to “code up” the entire application in high-
fidelity (“over simulating”). 

2. Get the Big Picture First 

2.1. iRise Website 

There is a wealth of information on our website explaining why large and small 
organizations worldwide have chosen iRise to visualize applications before building them. 
If you don’t really understand why you have been asked to use or evaluate iRise, you 
might want to spend an hour or so reviewing the extensive materials available at 
www.irise.com.  

2.2. Webinars and User Group Presentations 

Among the best materials on the website are video presentations by our customers, 
partners, and iRise professionals. For the most part, the recorded webinars, product 
videos (Product Tab), and user group presentations (Customer Tab) contain practical 
information and advice you can use to ensure successful use and adoption of iRise within 
your organization. 

Especially valuable and highly recommended for the iRise user are “Best Practices for 
Adopting Visualization into your Software Process,” and “Accelerating Visualization with 
Asset Libraries” (here, click the For the iRise User tab).  The first 10 minutes of each are 
basically the same marketing introduction, but worth listening to once.  The presentations 
that follow are about 40 minutes, including a question and answer period. 

2.3. Demonstrations 

Start with the three iRise Demo videos on the Product tab here, which will require about 
40 minutes of your time.  If you prefer the excitement of a live demonstration, we run a 

http://www.irise.com/resources/seminar_center.php
http://www.irise.com/resources/videocenter.php
http://www.irise.com/resources/videocenter.php
http://www.irise.com/resources/videocenter.php
http://www.irise.com/resources/seminar_center.php
http://www.irise.com/resources/videocenter.php
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half hour web demo every Tuesday and Thursday at 10:00AM Pacific (1:00PM Eastern, 
6:00PM GMT).  Sign up here.   

2.4. Product Videos 

Short narrated videos of specific product capabilities are also available under the Product 
tab.  Each one is just a few minutes, so view as many as you can.  We suggest viewing 
them in the following order: 

1. Scenarios 

2. Page Components in iRise 

3. Building Business Logic 

4. Datasheets 

5. RIA and iRise 

6. Masters & Templates 

7. Walk Through Notes 

8. Capturing Text Requirements 

9. Managing Feedback 

10. Collaboration 

11. The iDoc 

3. Training and Mentoring Options 

3.1. iRise Educational Services 

The iRise Professional Services organization offers a variety of educational services that 
can be tailored to meet the adoption and budget needs of large and small organizations. 

3.1.1. iRise eLearning 

Two free eLearning courses on the iRise website are strongly recommended for new 
iRise Studio users: iRise Overview (30 minutes), and iRise Explained (4 hours).  Other 
courses for project managers (2 hours), project stakeholders (30 minutes), and the iRise 
administrator (2 hours) are valuable for gaining a broader perspective. 

3.1.2. iRise Instructor Led Courses 

iRise Experienced is the core two day classroom training available on-site anywhere in 
the world or in various public locations in the U.S.  The program is also offered as a 
virtual training course.  More information is available here.  Instructor led training is a key 
predictor of successful iRise adoption.  iRise Expert, iRise Applied, and iRise Customized 
training are additional options.  Contact your iRise sales representative. 

3.2. Mentoring 

Product demonstrations, tutorials, and classroom training are essential elements of 
successful adoption, but mentoring goes directly to the heart of individual enablement. 

3.2.1. Visualization (Mentoring) Workbook 

This document was created by the iRise Inside Sales organization to help new users and 
evaluators get into some of the advanced capabilities of iRise quickly.  It focuses on 
modeling tasks that many new users find challenging, with particular emphasis on data 
interactions, using datasheets and the clipboard. It is a 80 page document that requires 
about 4 to 6 hours to go through completely. 

http://www.irise.com/news/web_demos.php
http://www.irise.com/resources/videocenter.php
http://www.irise.com/services/training_elearning.php
http://www.irise.com/services/training_elearning.php
http://www.irise.com/services/training.php
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3.2.2. Public Mentoring 

Every Friday at 10:00AM Pacific (1:00PM Eastern, 6:00PM GMT) iRise offers a live one 
hour public mentoring session.  The session covers many of the basics and has the 
advantage of stepping you though a live explanation.  Register here, and let the team 
help you get off to a good start with iRise. 

3.2.3. One-on-one Mentoring 

Your iRise sales representative can sometimes arrange individual mentoring to help you 
begin a successful evaluation or get off to a good start with the product.  Typically one-
hour, mentoring sessions can simply be a “deep dive” demonstration but they are most 
effective when you work together on a real project. 

3.2.4. iRise Mentoring Services 

The iRise Professional Services organization offers exceptional on-site mentoring that 
brings new users up to speed quickly while delivering real business value in the form of a 
successful project and the beginnings on an asset library.  This is a paid engagement 
defined by a Statement of Work.  Contact your iRise sales representative. 

4. On Your Own with iRise Studio 
We understand the desire to jump right in, but a little time up front will save you a lot of 
frustration later.  If you’ve skipped over the training and mentoring options and plunged right 
into iRise Studio, take some time to familiarize yourself with the iRise Studio user interface, 
and to go through the tutorials available on the Welcome screen and Help menu. 

You will need to have iRise Studio (either the trial software or your licensed copy) installed 
and running on your workstation.  You don’t need to be connected to the iRise Definition 
Center server, and in fact should do all your practice work on projects local to your machine 
unless directed otherwise. 

4.1. Quick Reference Card (10 minutes) 

You may not know what everything is or does yet, but review the Quick Reference card 
anyway to familiarize yourself with the iRise Studio user interface and terminology.  It will 
be time well spent. 

 Start iRise Studio.  Close any welcome or splash screens so you can get to the 
Help menu.  Select Quick Reference to view and study the PDF.  

4.2. Getting Started Guide (1 to 2 hours) 

Now it’s time to do some work.  You are going to build your first simulation.  Don’t just 
read about it—do it!  It will get you used to working with the iRise user interface. 

 From the Help menu, select Getting Started Guide.  Run each step in order, 
building the simulation in iRise Studio. 

4.3. Explore the Menus (10 minutes) 

Now that you’ve got your feet wet, let’s take a closer look at the menus.  

4.3.1. File Menu 

The File menu lets you create or open projects, and save projects with a new name.  You 
never need to save your work in iRise, so if you want to get back to where you were 
when you started your session, but sure to do a Save As before beginning.  It’s often a 
good idea to include a version number and date in the project name.  Use the Organizer 
to move projects into folders and to delete projects.   

http://www.irise.com/news/web_demos.php
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Importing and exporting iDoc files are common tasks.  You can send an iDoc to a 
reviewer who can run it (after downloading the iRise Reader from our website) and add 
comments to it, or to a co-worker who can import all or part of your iRise model into their 
own copy of iRise Studio (alternatively, you can collaborate on a project by hosting it on 
the iRise Definition Center server).  You can export screen shots, text requirements, and 
other details to an RTF (Word) file, and import comments from iDocs you have sent out 
for review. 

4.3.2. Edit Menu 

The edit menu has a lot of what you would expect (copy, paste, etc.), so we’ll just point 
out several of the most salient features.  The undo function in iRise is very robust. You 
can undo even a long series of changes using CTRL-Z, although you can’t undo 
datasheet actions. Also, note the difference between Paste and Paste from External.  
The latter is mainly for importing text and images from the Windows clipboard.  You also 
set your preferences on the Edit menu.  

4.3.3. View Menu 

Play around with the view menu to get a feel for some of the functions.  Showing widget 
boundaries applies mainly to Form and Section objects that may not have borders set.  
Read the Help text for the grid settings and try various combinations to set them the way 
you like.  You will always want to show the Details Panel, so make certain it is checked.  
Hide the Comments panel while you are modeling to make more room on the canvas.  

4.3.4. Format Menu 

You will want to learn to manage and edit styles.  When you choose Edit Style, pay 
attention to the style of the object that has the focus, since that is the style you will be 
editing.  It’s best to get into the habit of choosing the style you want to edit from the 
Manage Styles list, then apply the style to your object. That way, you won’t accidentally 
edit the wrong style. 

4.4. Learn about Widgets (1 hour) 

The iRise Studio Help system provides complete documentation.  Widgets include Page 
widgets and Canvas widgets. Study the Quick Reference Card (on the Help menu) for 
brief descriptions. 

You might want to create a new project (call it Test Widgets), and try dragging the 
widgets to the page or canvas so you can study their properties in the Details panel.  

4.5. Study Sample Simulations 

Studying sample simulations is one of the very best ways to learn how to model with 
iRise.  Not only will you see how the various kinds of widgets, actions, and links are used, 
you will learn many of the techniques that practiced users employ.  Don’t worry if they 
don’t make sense at first.  Keep at it and you will soon understand what is going on, or 
ask your iRise sales representative or technical contact for help. 

4.5.1. Common Samples iDoc 

Download the Common Samples iDoc from the iRise website Download Center and 
import it into iRise Studio (use FileNewProject from iDoc).  This invaluable resource 
demonstrates and explains how to create approximately 70 common design patterns at 
the beginner, intermediate, and advanced level. 

4.5.2. Sample iDocs 

Also download, import, and study the Simbank and Simwealth Management iDocs, and 
some of the others provided by iRise or its partners.  Also, ask your iRise sales 

http://www.irise.com/resources/idoc_library.php
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representative to send you samples they may have that are similar to what you will be 
building.  

4.6. iRise Help System 

Very few people enjoy reading manuals, but if you really want to build a solid foundation 
of iRise knowledge, bite the bullet and set aside the time to read the iRise Help system 
from front to back. It is very well written, if sometimes a little sparser than you would 
hope, and will reveal important details that can save you a lot of time and frustration. 

4.7. iRise Support 

One of the advantages of working with an enterprise software product like iRise is the 
support that is available to you by email and over the telephone.  iRise Support is not a 
substitute for training and reading the manual.  But iRise support personnel are highly 
skilled not only in solving installation and operation problems, but also in iRise modeling.  
They can tell you how to build something you’re having difficulty with, and also tell you if 
you’ve run into a bug (yes, we do have a few now and then, like any software).  If you 
send them an iDoc, they can debug it and send it back to you.  It’s a great way to 
communicate. 

5. Simulating with iRise Studio 
Once you start modeling your own projects, the following approach based on iRise best practices will 
increase your chances for success. 

5.1. Visualize with Screen Shots and Low Fidelity 

You will usually start by visualizing a workflow or use case of interest using iRise 
scenarios, and by creating “low fidelity” simulations.  Since most projects involve 
modifying or extending existing applications, you will want to focus first on learning to link 
and overlay screenshots to express the end to end workflow. 

5.2. Simulate New Functionality from Scratch 

Extending an application means building new functionality, so you will quickly need to 
learn how to visualize the UI by adding widgets to new pages and incorporating data to 
create a scripted experience.  From there, learn to create a more realistic experience by 
adding dynamic behaviors and data interactions, as well as by adding images and 
formatting.  

5.3. Simulate in High-Fidelity When Appropriate 

Creating high-fidelity simulations (from the point of view of look and functionality) is not 
called for in all situations, but when it is you will want to know how to use the advanced 
capabilities and techniques that make this possible.  You will learn many of these with 
practice and experience, but studying how others have created simulations helps 
tremendously. You can import examples from the iDoc files available on the iRise 
website. 

5.4. Optimize with an Asset Library & Collaboration 

As you progress, you will want to organize your simulation assets into an asset library, to 
facilitate reuse and to speed model development.  Last, but not least, learn the best 
practices for collaborating with reviewers, consumers, and other modelers to build and 
iterate your iRise simulation so you arrive at the ideal solution. 


